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Begin with Finishing

Folding is hardly the most
glamorous part of a print
project. But when it comes to
getting what you envisioned
on time and on budget, it's
one of the most important.

By TRISH WITKOWSKI AND PETER TRUSKIER

Folds are everywhere: brochures, direct mail, fold-out
covers, folded inserts bound into books. Although it
can be simple and standard or fun and creative, even
the most basic of folds can require careful thought
and planning. There’s a technical side to folding that’s
rarely talked about, yet understanding how to design
folded materials is a critical career skill. Once you're

in the know, you'll feel more confident about the files
you send to the printer, be happier with your finished
projects, and save money in the process.

This article covers the basics to consider before
you fold and takes you step-by-step through creating
a common (yet often bungled) folded document. We'll
also supply scripts that free you from some of the
tedious manual work.
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Think Before You Fold

Before we talk tech, let’s back up a bit. When you begin
to work on something like a brochure, you probably
start with a sketch, then come up with a cool layout,
get the client’s OK, and finally choose a printer and
send off the file. Basically, you do the fun stuff first and
worry about the details later.

The drawback to that workflow is that folding, even
though it happens after your project comes off the
press, has to be planned for if you don’t want to send
your costs sky-high.

Not all folds are created equal. Some require special
folding equipment, skilled bindery professionals,
slower run speeds, longer make-readies, and hand
work (translation: $5$59).

If you have an unlimited budget, you have nothing
to worry about, but otherwise, you need to be sure
your fold not only can be produced but can be
produced at a cost you can afford to pay. Talk to your
printer early and often in the concept stages, or you
may get burned.

,
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The other reason that finishing (anything that
happens to the sheet of paper after printing) is so
important is because of its place in the process. A
mistake caught at the finishing stage is the most
expensive mistake you can make. At that point, the
job has been through prepress, proofing, and the
pressroom. For each step in the workflow, the cost of
the error gets exponentially higher. A mistake caught
in the bindery almost always means a reprint, or an
undesirable work-around.

With that in mind, here are some things to think
about before you start a project that involves folding.

Do you know your audience?

You wouldn’t choose a delicate paper for a piece
intended for children, or a complex fold for an elderly
audience. Sometimes the folding style or materials
that would look best (and maybe even win design

awards) are inappropriate for the end user. Think about
who will receive the piece, have a paper dummy made

up, and test it.

Do you know your budget?

Before you show that creative fold to your client, run
it by your printer first. No client appreciates being
sold something they can't afford, and the budget-
conscious compromise will never be as good as the
original in their eyes. Be upfront with your printer
about your budgetary constraints; they may even

be able to help you get what you want. For example,
reducing the finished size of the piece slightly may
fit more of them on the press sheet, or may allow
you to drop your press sheet size. There may be

a comparable paper that is less expensive, or a
trimming trick that could make a nice effect without
adding much cost to the job.

Do you know your content?

This is really important. The way your content should
be organized has everything to do with how the
sheet is folded. Content placement isn't always an
intuitive decision; the reader may not open or read the
document in the order you intended.



For example, often when working on a roll fold
(Figure 1), designers usually put the most important
information on the two roll-in panels. The perception
is that people will open the piece and read the first
roll-in panel, then open it a little further to read

the second roll-in panel, and lastly open it out flat

to view the inside spread. The reality is that when
most people open a roll fold, they flatten it almost
immediately. They might eventually turn it over and
read the material on the roll-in panels, but the critical
real estate for the roll fold is the inside spread. If you
have text flowing from one panel to another, be sure
the reader knows where to go next or, no matter how
nice it looks, your design fails. The easiest way to find
out how the reader will respond is to make a folding
dummy of your layout and pass it around, watching
how people open it.

Do you know your method of distribution?

Will it be a self-mailer? If so, there are postal
regulations and wafer seal or glue requirements.

Talk to the post office, which has staff dedicated to
qualifying mail. If your piece will be mailed in an
envelope, auto-insertion can be a problem for some
folding styles, particularly the accordion fold, so ask
your printer about that. Do you know the size of the
envelope, and how small your piece needs to be to fit
in the envelope? If other pieces will go in the envelope
with the brochure, you may need to make the main
piece a little smaller than the recommended enclosure
size since the added bulk will take up space.
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Figure 1: People may not read a roll fold the way you think.

Folding Guidelines

You can boil down folding guidelines into four areas:
compensation, edges (trims, margins, pages), and
setting fold marks.

Compensation. Folding is dimensional, and because
of this, if panel 1 is to fold into panel 2 and lie
flat, panel 1 must be slightly smaller. That'’s called
compensation. If you don’t compensate, the folded
piece will telescope, or have a roundish profile
because the panels are too long and push against
each other. No bindery will let telescoping happen.
Rather, they’ll adjust the fold placement so that the
brochure will lie flat, but margins and color breaks
may shift noticeably. Not good!

To truly understand compensation, let’s make
a four-panel roll fold dummy. Start with a standard
sheet of paper and divide it into four equal panels.
Fold the farthest right panel in, fold it in again, and
close the cover. It will telescope because the farthest
right panel must fold into the next panel, which folds
into another. So the farthest right panel gets twice the
compensation of the panel to its left, and the last two
panels, since they're not folding into anything, don't
require any compensation.

Now flip the dummy over and you'll notice that
the narrowest panel now falls on the left—everything
reverses for side two of the brochure.



There’s a simple rule for calculating the panel
differences: Shorten the fold-in panel by 3/32" to 1/8".
If the fold-in panel is broadside (two-sheet thickness)
or in heavy cover stock, increase the compensation to
1/8"to 3/16".

The step-by-step how-to on page 13 gives you
valuable techniques and tools for creating the digital
document that includes these calculations.

Trims, margins, pages, etc. We've seen many ways

of building a digital file for folding. Some float the
brochure on a larger page with crop marks, some
create separate documents for side one and side two,
some build the file in viewing spreads. We recommend
creating a single two-page document. Build the

document size to the final trim size of the piece.
Trim size (also called flat size) is the size of the final
brochure—including folding compensation—when
laid out flat. Pull the bleed past the edge as you would
with any other print project.

There are no rules regarding what margins should
be.The key is not to question the margin amount,
but rather the width and placement of the text frame
when a panel is compensated. It can add up to a
noticeable difference when not adjusted correctly.

Setting fold marks. Placing one of InDesign’s guides
is not enough to show the printer where to fold the
sheet. You need to create fold marks. Once you've set
fold guides, draw a short, vertical dotted or dashed

\
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Eight-page broadside fold

s

Map fold

line directly above the first guide, making sure it's in
the slug area and not crossing onto the document
edge. Then, follow the guide straight down and make
another vertical line just below the guide, off onto the
slug area. Zoom out, group both lines, copy and paste,
and place them on the next guide. Continue this until
all folding guides have fold marks above and below.
Want to save time? Run a fold mark script instead. (See
the “Scripts” sidebar on page 17 for details, including
directions for getting the scripts.)

When you've finished, print the document with
bleeds and crop marks, trim it, fold it down and make
sure you didn’t miscalculate or misplace any of the
folds. If everything looks good, you're ready to start
designing.

\

Four-page standard fold Double-parallel fold



——  Figure2 Fold by Fold, Step by Step Figure 3
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Once you know the desired width for each of the

panels, make a simple sketch you can refer to
while building your document. In Figure 3, both sides
of the piece are shown with Panel A (the front cover)
on the right of the outside page and on the left of the
inside page.

Using the standard compensation values, the panel

widths should be as follows:

o D. 4-13/16"

! ’I Plan it out

NS08

C. 4-29/32"
B. 5"
A. 5"
Folding Lingo
Flat size vs. finished size Mechanical fold vs. hand fold pages. If you take that fold and make it a Broadside
The flat size is the exact dimension of the piece when A mechanical fold is any fold that can be done by Accordion—a broadside fold doubles its area by folding
laid flat. This measurement should include all folding machine. Hand folds must be done completely or in half on itself before any characteristic folding style is
compensations, but should never include bleed partially by hand. Often, printers take folds as far as they created—the fold changes to six panels and the page
allowances because bleed is pulled past the edge of the can go by machine, then bindery workers do the last fold count rises to twelve.
page in the digital document. Digital document page or two by hand. Some folding styles that are considered
dimensions and flat size should always be the same hand folds can be done by machine at specialty
measurement. Finished size is the exact dimension of the binderies. Hand folding is very expensive and requires a
piece when completely folded. die-score and more time built into the finishing schedule.
4"x 7" Letter Fold—flat size . 4"xT" Letter Fold—finished size 1o 1c |/ pages UREE
Forrl Backover coner Panels are two-sided sections of the final folded piece. A ’
page is one side of a panel. The Accordion fold below is
A L three panels; each of the panels is two-sided, and each Panel
side is a page. So, the three-panel Accordion has six
i Page
S| |
; : — |
¥ Left: Flat vs. Right: Panels L |
| 11.906" | — — finished size. vs. pages. T [
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To avoid dealing with fractions or lots of decimal
places in InDesign, and also to minimize InDesign
rounding errors, use points to define your document
and create the guides that will denote the panel
boundaries. Since there are 72 points per inch,
multiply each of the four panel widths in inches by 72.
Also multiply the finished 8" height of the piece by 72.
These are the values marked on Figure 3.

Create the document

Add the widths of the four panels (346.5 + 353.75

+ 360 + 360) to calculate the desired width of the
document: 1419.75 points. Its height will be 576 points.

Enter the values in the New Document dialog
box (Figure 4). If you use our utility scripts (see the
“Scripts” sidebar on page 17), you only need to create
a one-page document; you'll use the mirroring script
to automatically create the second page after you've
made the guides on the first page.

In the New Document dialog box, specify the
amount of bleed you want, and add a slug area to
contain the fold marks. (Our fold mark utility script
will expand the slug as necessary to hold the folding
marks, so you can omit this now if you plan to use the
supplied script.)
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New Document

Document Preset: | [Custom] I C] f—H
Number of Pages: 1 [l Facing Pages € Cancel )

] Master Text Frame

— Page Size: | Custom B
Width: = 1419.75 pt  Orientation:

Height: <576 pt

( save Preset... )

( Fewer Options )

— Columns
Number: =1 Gutter: =+ 12 pt
— Margins
Top: =0 pt Left: =0 pt
Bottom: =0 pt Right: <0 pt

— Bleed and Slug

Top Bottom Left Right
Bleed: 9 pt 9 pt 9 pt 9 pt ﬂ
Slug: 36 pt | 36pt  36pt  36pt |

Figure 4

Create a new layer

It's a good idea to place marks and guides on

their own layer beneath all other layers in the
stacking order. Now’s the time to create and select this
layer. (After you've created all the guides and marks,
you may want to lock this layer to prevent accidentally
moving anything.)

The plug-in for
real mathematical typesetting

“Thanks, | just upgraded my 1.5 license and purchased 2 more. The
software you developed is wonderful. We do work for school book
publishers and it has worked wonderfully. If you would ever like to use
our company as a reference, we would be happy to do so.

Peter Fenelon, Composure Graphics, Nashotah, WI, USA

““Also, you may mention us as an In Math user on your web site, because
we like to see the result by using InMath with Adobe InDesign CS2
software. Thank you again. ¢
Shu, Ming Xiao, Nanjnig Ligong Publishing Info & Tech Co. Ltd, China

‘| have been using InMath for a number of months now - this is an
outstanding program that has greatly simplified the process of setting
mathematical and scientific publications.

Craig Farham, The Science Press, Cape Town, South Africa

¢... werde gleich loslegen. Natiirlich diirft ihr uns nennen, euer Pro-

gramm ist ja schlieBlich super!!¢
Hanne Schneider, hutt kommunikation, Stuttgart, Germany

B InMath® depicts mathematical equations solely by

native InDesign/InCopy text editor means.

B No particular fonts needed.

B No single graphical element.

B All settings organized as ,,styles*.
B Tried and tested all over the world.
it

More information and test version here: http://itip-gmbh.eu
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4 Create the first guide

Drag a vertical ruler guide from the left ruler of

the document window. Release the mouse when

the guide is in the vicinity of the desired position
(346.5 points).

To precisely position the first guide after dragging

it on to the page, make sure it's selected (it will be just

after you've created it) and enter its desired position

in the numeric field in the Control panel/palette
(Figure 5).

Figure 5

‘,Oa Untitled-3 @ 5%

f 0 L B e e Tles Rur Tos i Jews Jrme foc fws v Juoes Jiewo Rs: Jizzs e T [
¥

Er

LT | & & b

i . v " L o

B

r [ G % L 7

r LA [

I‘ | Ecubs & paris L]

. T ]

i

it

i

i
e o =T %1 =T+ (8 e o s c———— )

20  October | November 2007

You can also use the Edit > Step and Repeat

menu option to duplicate a guide at a precise
horizontal or vertical offset. To create the second
guide, select the first one by clicking on it with the
Selection Tool, and choose Step and Repeat... from the
Edit menu. In the Step and Repeat dialog box, enter
“1"for the Repeat Count, and enter the width of panel
C (353.25 points) in the Horizontal Offset field. We also
like to turn on the Preview checkbox (Figure 6).

5 Create the second guide

Figure 6
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Create the final guide

Select the second guide, and Step and Repeat it

by the width of panel B (360 points) to create the
final guide on page 1.

Before moving on to page 2, double-check that

all the guides are in the correct position. Make
sure Snap To Guides is turned on (under the View >
Grids & Guides menu), and use the Measure Tool and
Info Panel to measure the distance between each pair
of guides (or page edges) and compare to your sketch
for accuracy (Figure 7).

7 Check your work

Figure 7
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“SOFTWARE

FontExpert 2007 ver 9.0
Font Manager for Windows

with

Missing Fonts Loader Plug-In
for Adobe InDesign -

Activates missing fonts
automatically

Pnce $59, including the plug-in.
Free trial version is available.

ProximaSoftware.com
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Make page two

Your document needs a second page, and its

guide positions need to be horizontally mirrored
relative to page 1—that is, panel A (one of the 360
point panels) is on the left of page 2, and panel D (the
narrowest) is on the right.

You could manually create a second page, and
follow the previous steps to create the guides.
However, it’s a lot easier to use our script attached to
this article (Create Page and Mirror Guides.jsx). This
script will create a new page, and create a new set of
guides on it, mirroring the position of all the guides on
page 1. When you run the script (by double-clicking
it in the Scripts Panel), it will display a dialog box with
a popup menu in which you select the direction(s)
in which you want to mirror the guides (Horizontally,
Vertically, or Both). In this case, we want to mirror
horizontally (Figure 8).

The result will look like Figure 9.
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Create fold marks

The final step in building your document is to

create fold marks in the slug area. You could
create these manually, but once again, InDesign
scripting comes to the rescue, eliminating the need
for tedious, error-prone work. Our script Make Fold
Marks on Guides.jsx will first expand the slug area
(if necessary to accommodate the marks it's going
to create), and then create fold marks in the slug
area for all guides on visible layers in your document
(Figure 10).

Time for text and images
With your document set up this way, you're
well-prepared. Time to place text and images!

Finshing at the Beginning

A successful folded project and a smooth workflow
process take thought, planning, and some technical
know-how. But with a little practice, you'll feel
confident about what you're doing. If you remember
only one thing from this article, make it this: Think
finishing at the beginning. Resist the temptation to
design in a vacuum and get your printer’s opinion
early. Then have fun creating your masterpiece.

Trish Witkowski is president of Finishing Experts Group, Inc., and is

the creator of the award-winning FOLDRite brochure folding system.

Peter Truskier is a partner at Premedia Systems, a publishing
workflow consulting company in the San Francisco Bay area.

InDesidn

MAGAZINE

= H.v =
-‘b\'ur« Fage mv.-...-r.,..g

. i Fe s O G @

Figure 10

Scripts
We've created two scripts to simplify the task of building
an InDesign document with guides and folding marks:
) Create Page and Mirror Guides.jsx
) Make Fold Marks On Guides.jsx

The scripts are attached to this PDF—you'll see them
if you click on Acrobat’s paperclip icon. Both scripts
work with InDesign CS2 and CS3 on Mac and Windows.

To use the scripts, place them in the following folder,
depending on your version of InDesign:
InDesign CS2—InDesign application folder > Presets
folder > Scripts folder
InDesign CS3—InDesign application folder > Scripts
folder > Scripts Panel folder

For better organization and less clutter, place scripts
in folders nested within your Scripts folder.

To run one of these scripts, display the Scripts panel
(the Scripts palette in CS2), locate the script in the list,
and double-click.

Resources
If you don't have the time or the desire to come up with
a folding plan on your own, there’s plenty of help.

Templates
Search the Web for InDesign templates and you'll get a
lot of hits like these:

) www.stocklayouts.com

) www.ideabook.com/indesign_templates.html

} Also, some printers offer a wide variety of folded-
product templates. Here’s one example:
http://savoirprint.com/sitehelp/help/helpful
subjects/folding+templates.html

) Don't forget the templates that ship with InDesign.
Access them by going to Help > Welcome Screen...,
and click on Create New...From Template.

) For custom digital folding templates in a snap, check
out the new FOLDRite Template Master plug-in for
InDesign (available November 2007). Visit www.
foldfactory.com for more information and to view
a demo. If you visit the site and pre-register, you'll
be eligible for a special promotional price and other
offers.

Books

) FOLD: The Professional’s Guide to Folding, by
Trish Witkowski

) Formes, Folds, and Sizes: All the Details Graphic Designers

Need to Know but Can Never Find, by Poppy Evans
) The Packaging and Design Templates Sourcebook, by
Luke Herriott



http://www.premediasystems.com/
http://www.stocklayouts.com/default.aspx?campaign=cproindmag
www.ideabook.com/indesign_templates.html
http://savoirprint.com/sitehelp/help/helpful_subjects/folding+templates.html
http://savoirprint.com/sitehelp/help/helpful_subjects/folding+templates.html
http://www.networkpdf.com/foldrite
http://www.networkpdf.com/foldrite
http://www.amazon.com/Fold-Professionals-Guide-Folding-2/dp/0972341803/creativeprocom/
http://www.amazon.com/Forms-Folds-Sizes-Details-Designers/dp/1592530540/creativeprocom/
http://www.amazon.com/Forms-Folds-Sizes-Details-Designers/dp/1592530540/creativeprocom/
http://www.amazon.com/Packaging-Design-Templates-Sourcebook-Graphic/dp/2940361738/creativeprocom/
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#target indesign

//////////////////////////////////////////////////////////////////////
//          This script is provided along with an article           //
//              in InDesign Magazine - October, 2007.               //
//                                                                  //
//              Copyright ©2007 Premedia Systems, Inc.              //
//         You may freely use and re-distribute this script,        //
//                     but you may not sell it.                     //
//                                                                  //
//      Please send questions, comments, suggestions                //
//                        and improvements to:                      //
//                     peter@premediasystems.com                    //
//////////////////////////////////////////////////////////////////////

main();

function main(){
	//is there a document open?
	if (app.documents.length != 0){  
		
		var myDialog = app.dialogs.add({name:"Mirror Guides", canCancel:true});
			with(myDialog){
				
			//Add a dialog column.
			with(dialogColumns.add()){
				
				//Create a border panel.
				with(borderPanels.add()){
					with(dialogColumns.add()){
					staticTexts.add({staticLabel:"Mirror:"});
					}
					var myDropdown = dropdowns.add({stringList:
					["Mirror Horizontally", "Mirror Vertically", "Mirror Both"], selectedIndex:0});
				}
			}
		
		//Display the dialog box.
		if(myDialog.show() == true){
			
			//Get the vertical justification setting from the pop-up menu.
			var myMirror = myDropdown.selectedIndex;
			
			//Set a refernce to our current document
			var theDoc = app.activeDocument;  
			
			//We'll always deal with the first page as the front side
			var thePage = theDoc.pages[0];
			
			//Set the ruler origin style
			theDoc.viewPreferences.rulerOrigin = RulerOrigin.pageOrigin;
			
			//Save the current origin point...
			var theOldZero = theDoc.zeroPoint
			
			//...and set the document origin to 0,0.
			theDoc.zeroPoint = [0,0];
			
			//Grab the current units of measure...
			var theOldHUnits = theDoc.viewPreferences.horizontalMeasurementUnits;
			var theOldVUnits = theDoc.viewPreferences.verticalMeasurementUnits;
			
			//...and set them to points
			theDoc.viewPreferences.horizontalMeasurementUnits = MeasurementUnits.POINTS;
			theDoc.viewPreferences.verticalMeasurementUnits = MeasurementUnits.POINTS;
			
			//Grab the page's guides
			var theGuides = thePage.guides;
			
			//Create a new page for the back of our piece
			
			var theNewPage = theDoc.pages.add();
			
			//Get the document width... 
			var theWidth = theDoc.documentPreferences.pageWidth;
			
			//... and its height
			var theHeight = theDoc.documentPreferences.pageHeight;
			
			  //Go through each guide of the first page
			  for (var j = 0 ; j <= (theGuides.length - 1); j++) {  
				  
					//Get a reference to the guide
					var aGuide = theGuides[j];
					
					//Get its position...
					var thePos = aGuide.location;
					
					//... and its layer - note that we assume the layer is unlocked...
					var theLayer = aGuide.itemLayer;
					
					//...and whether it stops at the page edge or extends onto the pasteboard
					var theFit = aGuide.fitToPage
					
					//Finally, get its color
					var theColor = aGuide.guideColor;
					
					//Either mirror the guide onto page 2 or simply copy, 
					//depending on the user's mirror selection from the dialog box
					if (aGuide.orientation == HorizontalOrVertical.vertical){
						if (myMirror != 1) {
							theNewPage.guides.add(undefined,{orientation:HorizontalOrVertical.vertical,location:theWidth - thePos, itemLayer:theLayer, guideColor:theColor, fitToPage:theFit});
							}
						else{
							theNewPage.guides.add(undefined,{orientation:HorizontalOrVertical.vertical,location:thePos, itemLayer:theLayer, guideColor:theColor, fitToPage:theFit});
							}
						}
					else{
						if (myMirror != 0) {
							theNewPage.guides.add(undefined,{orientation:HorizontalOrVertical.horizontal,location:theHeight - thePos, itemLayer:theLayer, guideColor:theColor, fitToPage:theFit});
							}else{
							theNewPage.guides.add(undefined,{orientation:HorizontalOrVertical.horizontal,location:thePos, itemLayer:theLayer, guideColor:theColor, fitToPage:theFit});
							}
						}
				}
			
			//Return the document to its previous state - restore the origin point...
			theDoc.zeroPoint = theOldZero;
			
			//...and the measurement units
			theDoc.viewPreferences.horizontalMeasurementUnits = theOldHUnits;
			theDoc.viewPreferences.verticalMeasurementUnits = theOldVUnits;
			
			//Remove the dialog box from memory.
			myDialog.destroy();
			}
		}	
	} else {  
	  alert("No documents are open.");  
	}
}



#target indesign

//////////////////////////////////////////////////////////////////////
//          This script is provided along with an article           //
//              in InDesign Magazine - October, 2007.               //
//                                                                  //
//              Copyright ©2007 Premedia Systems, Inc.              //
//         You may freely use and re-distribute this script,        //
//                     but you may not sell it.                     //
//                                                                  //
//      Please send questions, comments, suggestions                //
//                        and improvements to:                      //
//                     peter@premediasystems.com                    //
//////////////////////////////////////////////////////////////////////

const minSlugDim = 36;
const minMarkOffset = 9;

main();

function main(){
	
	//Is there a dcoument open?
	if (app.documents.length != 0){  
		
		//Get a reference to our current document
		var theDoc = app.activeDocument;  
		theDoc.viewPreferences.rulerOrigin = RulerOrigin.pageOrigin;
		
		//Grab its pages
		var thePages = theDoc.pages;
		
		//Set a refeernce to stroke style 16 - "dashed" - which 
		//is what we want to use for the fold marks
		var theStrokeStyle=theDoc.strokeStyles.item(16);
		
		//Save the current origin point...
		var theOldZero = theDoc.zeroPoint
		
		//...and set the document origin to 0,0
		theDoc.zeroPoint = [0,0];
		
		//Save the current units of measure...
		var theOldHUnits = theDoc.viewPreferences.horizontalMeasurementUnits;
		var theOldVUnits = theDoc.viewPreferences.verticalMeasurementUnits;
		
		//...and set UOM to points
		theDoc.viewPreferences.horizontalMeasurementUnits = MeasurementUnits.POINTS;
		theDoc.viewPreferences.verticalMeasurementUnits = MeasurementUnits.POINTS;
		
		//Get the document width...
		var theWidth = theDoc.documentPreferences.pageWidth;
		
		//...and height
		var theHeight = theDoc.documentPreferences.pageHeight;
		
		//Set the slug sizes to be AT LEAST minSlugDim
		if (theDoc.documentPreferences.slugBottomOffset < minSlugDim){
				theDoc.documentPreferences.slugBottomOffset = minSlugDim
		}
		if (theDoc.documentPreferences.slugInsideOrLeftOffset < minSlugDim){
				theDoc.documentPreferences.slugInsideOrLeftOffset = minSlugDim
		}
		if (theDoc.documentPreferences.slugRightOrOutsideOffset < minSlugDim){
				theDoc.documentPreferences.slugRightOrOutsideOffset = minSlugDim
		}
		if (theDoc.documentPreferences.slugTopOffset < minSlugDim){
				theDoc.documentPreferences.slugTopOffset = minSlugDim
		}
	
		//Go through the pages
		for (var i = 0 ; i <= (thePages.length - 1); i++){
			
			//Get a page...
			var thePage = theDoc.pages[i];
			
			//...and grab its guides
			var theGuides = thePage.guides;
			
			//Go through each guide
			for (var j = 0 ; j <= (theGuides.length - 1); j++) {  
				
				//Get a reference to the guide
				var aGuide = theGuides[j];
				
				//Get its its position...
				var thePos = aGuide.location;
				
				//...and its layer - note that we assume the layer is unlocked...
				var theLayer = aGuide.itemLayer;
				
				//Ignore non-visble layers
				if (theLayer.visible){
					if (aGuide.orientation == HorizontalOrVertical.vertical){
						
						//vertical
						var theLine = thePage.graphicLines.add(theLayer,
							{strokeColor:"Black",strokeWeight:0.5,strokeType:theStrokeStyle,geometricBounds:[-minSlugDim,thePos,-minMarkOffset, thePos]});
							theLine.strokeDashAndGap = [3,3];
						 theLine = thePage.graphicLines.add(theLayer,
							{strokeColor:"Black",strokeWeight:0.5,strokeType:theStrokeStyle,geometricBounds:[theHeight+minMarkOffset,thePos,theHeight+minSlugDim, thePos]});
							theLine.strokeDashAndGap = [3,3];
						}
					else{
						
						//horizontal
						var theLine =thePage.graphicLines.add(theLayer,
							{strokeColor:"Black",strokeWeight:0.5,strokeType:theStrokeStyle,geometricBounds:[thePos,-minSlugDim,thePos,-minMarkOffset]});
							theLine.strokeDashAndGap = [3,3];
						theLine =thePage.graphicLines.add(theLayer,
							{strokeColor:"Black",strokeWeight:0.5,strokeType:theStrokeStyle,geometricBounds:[thePos,theWidth+minMarkOffset,thePos,theWidth+minSlugDim]});
							theLine.strokeDashAndGap = [3,3];
						}
				}
			}
		}
	
		//Return the document to its previous state-Restore the origin point...
		theDoc.zeroPoint = theOldZero;
		
		//...and the measurement units
		theDoc.viewPreferences.horizontalMeasurementUnits = theOldHUnits;
		theDoc.viewPreferences.verticalMeasurementUnits = theOldVUnits;
	} else {  
	  alert("No documents are open.");  
	}
}


	Show 4: 
	Page 1: Off

	Contents 4: 
	Page 1: Off

	Next_page 4: 
	Page 1: Off

	Full_Screen 4: 
	Page 1: Off

	Hide 4: 
	Page 1: Off

	Show 2: 
	Page 9: 
	Page 10: 
	Page 11: 
	Page 12: 
	Page 13: 
	Page 14: 
	Page 15: 
	Page 16: 
	Page 17: 

	Contents 2: 
	Page 9: 
	Page 10: 
	Page 11: 
	Page 12: 
	Page 13: 
	Page 14: 
	Page 15: 
	Page 16: 
	Page 17: 

	Previous_page 3: 
	Page 9: 
	Page 10: 
	Page 11: 
	Page 12: 
	Page 13: 
	Page 14: 
	Page 15: 
	Page 16: 
	Page 17: 

	Next_page 3: 
	Page 9: 
	Page 10: 
	Page 11: 
	Page 12: 
	Page 13: 
	Page 14: 
	Page 15: 
	Page 16: 
	Page 17: 

	Full_Screen 2: 
	Page 9: 
	Page 10: 
	Page 11: 
	Page 12: 
	Page 13: 
	Page 14: 
	Page 15: 
	Page 16: 
	Page 17: 

	Hide 2: 
	Page 9: 
	Page 10: 
	Page 11: 
	Page 12: 
	Page 13: 
	Page 14: 
	Page 15: 
	Page 16: 
	Page 17: 



